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Ce document décrit les limites et les problèmes connus d'Autodesk Mudbox 2013 Service Pack 1, ainsi 

que les solutions apportées à la version précédente. Il est vivement recommandé de lire ce document 

avant d'installer cette version.  
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 Corrections 

La liste suivante présente les numéros des bogues et les descriptions des problèmes corrigés dans cette 
version. 
 

Numéro de bogue Description 

MDBX-1628 Need a curve property for controlling virtual "pressure" along the curve for 
Stroke on Curve. 

MDBX-1657 Pressing the Shift key in the Create Curve tool should switch to the Smooth 
Curve tool. 

MDBX-1569 Curve end points are not fixed and the Smooth Curve tool will cause them to 
change. 

MDBX-1536 Grab Curve and Smooth Curve tools do not work on curves without splines. 

MDBX-1488 Cannot create a View Curve after pressing Ctrl+N (to create a new scene). 

MDBX-1442 Grab Curve and Smooth Curve marking menus are incorrect. 

MDBX-1382 Snapping to 3D curve doesn't work on the stencil canvas and may cause crash. 
This functionality has been removed. 

MDBX-1202 View curves break the "Frame Selection" function. 

MDBX-1339 "Snap to Curve" doesn't snap reliably. 

MDBX-1659 Sculpting on tiling plane after deleting some of the faces may cause Mudbox to 
crash. The ability to delete tiling plane faces has been removed. 

MDBX-940 Mudbox environment variable MUDBOX2009_SUBDIVIDE_SMOOTH_UV does 
not accurately match RenderMan UV Smoothing option -- cc smooth borders 
and internal UV's. 

MDBX-8 Subdivide with Smooth UV's is incorrect and should match RenderMan -- linear 
(unchanged) border with cc smoothed internal UV's. 

MDBX-1482 When importing an FBX file that has both blend shapes and creasing from Maya 
2013, the blends shapes fail to load into Mudbox 2013. 

MDBX-1751 PTEX export causes seams in some cases. 

MDBX-1406 Cannot mirror individual sculpt layer if other layers are visible. 

MDBX-1215 Layer > Mirror command produces incorrect result. 

MDBX-1387 Mac OS X: error beeps while clicking on Spacebar marking menu. 

MDBX-1720 Help preference set to use the Installed Local Help instead of Autodesk Web 
Site does not launch 2013 Help. 

Notes de version d'Autodesk Mudbox 2013 Service Pack 1 
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Remarques et limites fonctionnelles 

Cette section présente les limites connues de Mudbox 2013 Service Pack 1 et les solutions qui y sont 

apportées.  

Pour signaler tout autre problème, utilisez le formulaire en ligne prévu à cet effet à l'adresse  

www.autodesk.com/mudbox-bugreport ou sélectionnez Aide > Signaler un problème dans Mudbox. 

Numéro de bogue Description 

MDBX-1663 

Mac OS X: File > Send To is not working correctly. Maya or Mudbox will open 
when you select "Send to.." but nothing will be sent. 
Workaround: 
1. Copy the libsynHub.dylib from the Mudbox 2013 SP1 directory:  
/Applications/Autodesk/Mudbox2013/Mudbox.app/Contents/MacOS  
2. Replace the file of the same name in the Maya 2013 directory  
/Applications/Autodesk/maya2013/Maya.app/Contents/MacOS 

388437 

The Gigatexel Engine stops working intermittently after assigning a new 
material or Ptex setup.  
Workaround: Toggle the visibility of the offending paint layer on and off, create 
a new paint layer (can be empty or hidden), or save the file and reopen it to 
restart the Gigatexel Engine.  
You need to start the Gigatexel Engine with this workaround before painting, 
otherwise textures on some tiles will go missing. 

MDBX-1616 
An environment variable MUDBOX_EXPOSE_8K exposes "8192" in the Create 
New Paint Layer "Size" option. (It will not be exposed if less than 512 MB GPU 
available. 1.5 GB or more recommended). 

MDBX-371 

When the amount of texture data exceeds the available GPU on your machine, 
the effects brushes draw red temporarily if "Solo as Diffuse" is ON for a paint 
layer.  
Workaround: Once the stroke is done, the brush correctly applies the effect 
and the result is correct. You can turn off the Gigatexel Engine in the Render  
preferences (which effectively disables the paint buffer) and the effects 
brushes will work correctly. 

388529 

Flip a mesh with crease information and an empty paint layers may cause faces 
to become transparent. 
Workaround: Delete the empty paint layer, or subdivide the mesh, or  
change subdivision levels. 

355918 
Installation: Error that says the product key may be invalid and to re-enter it. 
Workaround: Click OK on this dialog, click Next button again, and if product key 
is valid the installation continues. 

357041 

Mudbox on Linux does not get pressure events from Wacom tablets with 
Fedora 12/Redhat 6, QT 4.5. You can find more details in the bug report here:  
https://bugzilla.redhat.com/show_bug.cgi?id=569132 
There is a patch for Qt here:  
http://koji.fedoraproject.org/koji/buildinfo?buildID=160252 

358312 
Files that include 16 bit TIF maps will show errors with "Send to Maya..." 
operation. 

360224 
Mudbox crashes if the extraction map output file name contains %S in string 
(for example: AO_(%S).bmp). 

362133 
Creating a joint with Topology Weights doesn't work properly with non-4-sided 
meshes. Workaround: Use alternative Weights method. 

https://bugzilla.redhat.com/show_bug.cgi?id=569132
http://koji.fedoraproject.org/koji/buildinfo?buildID=160252
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Numéro de bogue Description 

362857 

If the level of the source model is not the current level when extracting a map, 
the detail of lower sculpt layers will be missing.  Workaround: Ensure you 
display the required subdivision level before extracting the map, or select the 
current level in the Extract Texture Maps window to get the correct result. 

363366 
Transfer paint layer works incorrectly if target and source have overlapping 
UVs. 

MDBX-260 

The Transfer Details function works best on objects that are the same size, or 
larger than the default Mudbox meshes. If the transfer produces artifacts on 
the target mesh, try scaling up the source and target meshes to the same size 
as the default head mesh. 

374126 
When using a non US-English standard keyboard, some of the hotkeys may not 
work. Workaround: Set your IME to "English - United States" while using 
Mudbox. For more information see your operating system documentation. 

MDBX-292 
Send to 3ds Max: Changing units between Max and Mudbox causes 
unpredictable results. 

381496 
When painting or sculpting with symmetry ON, sometimes the result will not 
appear on the opposite side. Verify that you have "Falloff based on Facing 
Angle" turned off. 

MDBX-1614 

On Linux, if Mudbox crashes when starting up with an error message such as 
"mudbox: symbol lookup error: /usr/lib64/libssl.so.0.9.8: undefined symbol: 
X509_VERIFY_PARAM_new", try the following workaround:  
1. Install OpenSSL >= 1.0.0 if you haven’t already. 
2. Point the old symbol link to the 1.0.0 version, like "ln -s -f 
/usr/lib64/libssl.so.1.0.0b /usr/lib64/libssl.so.0.9.8"  

MDBX-1203 
If a portion of a curve on a mesh is obscured (for instance, if a portion of the 
curve is on the back side of an object) and you use Stroke on Curve" with mirror 
ON, results may be incorrect. 

MDBX-456 
On Linux Fedora 14+ the SELinux is false by default. This may prevent Mudbox 
from launching properly and produce plugin errors. A possible workaround is to 
set the SELinux enforcing mode to "Permissive" or "Disable". 

MDBX-341 
When saving a .mud file to replace the original .mud file with the same name 
the file will also keep the original file size. To save the file with the actual file 
size use "Save Scene As..." and save the file with a new name. 

MDBX-1556 
On Mac OS X the installer may hang at end of a successful installation. It is 
recommended to force quit the installer. Mudbox will then run normally. 

 

 Pour exécuter Mudbox 2013, vous devez être équipé d'un processeur compatible SSE3. Mudbox 

utilise du code spécifique à SSE3, qui ne lui permet pas de s'exécuter sur du matériel compatible 

SSE2 ou version antérieure.  

 Si la propriété Espacement du tampon est activée pendant la sculpture, le tampon du pinceau est 

décalé par rapport à la position du curseur lorsque vous utilisez une tablette Wacom Cintiq ou 

Wacom et que le paramétrage du stylet est défini en mode souris. Pour résoudre ce problème, 

ajoutez la variable d'environnement "MUDBOX_USE_LOWRES_TABLET_DATA".  

 Avec les cartes graphiques ATI, si la peinture de texture est corrompue, par exemple si vous 

observez de la peinture noire ou des artefacts, l'ajout de la variable d'environnement 

"MUDBOX_PAINT_CONTEXT_FLUSH" peut résoudre le problème. 
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 Il peut arriver qu'une erreur de mémoire vive GPU soit signalée, ce qui entraîne l'affichage de 

nombreux avertissements à chaque fois que l'utilisateur crée ou fusionne des couches, ou modifie 

leur visibilité. La variable d'environnement "MUDBOX_FORCE_GPU_RAM" (sous Windows 

uniquement) vous permet de remplacer la quantité de mémoire GPU en méga-octets que Mudbox 

détecte. Si vous possédez une carte NVIDIA Quadro 5600 qui signale 1 Mo de mémoire vive GPU (le 

matériel présente 1,5 Go), définissez la variable sur 1536 (soit 1,5 x 1024) pour cette carte. Les 

valeurs non numériques sont ignorées et les valeurs numériques seront comprises entre 256 et 

4096. 

Remarque : pour plus d'informations sur ces variables d'environnement, reportez-vous à la rubrique 

Variables d'environnement de l'aide de Mudbox.  

 Vous pouvez télécharger et installer localement l'aide de Mudbox à partir du site 

http://www.autodesk.com/mudbox-helpdownload-fra. 

 Si vous avez installé une version bêta (y compris des versions Release Candidate) 

d'Autodesk Mudbox 2013, vous devez désinstaller et supprimer tous les dossiers système des 

versions de pré-publication avant d'installer la version commerciale.  

(Windows 32 bits ou 64 bits) La désinstallation ou la réparation de Mudbox 2013 échoue et affiche le 

message suivant : « SetupRes.dll n'est pas détectée ». 

Ce message d'erreur d'échec de maintenance se produit si Autodesk Mudbox 2013 a été installé comme 
partie d'une suite ou à partir d'une image autonome et que la langue sélectionnée pour le produit est 
différente des quatre qui sont prises en charge par Mudbox (anglais, français, japonais, allemand).  

 
Correction : Vous aurez besoin de privilèges d'administrateur. Apportez les modifications suivantes 
au registre et essayez de le réparer ou supprimer : 
 
Pour Windows 64 bits  
Clé : HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\Autodesk 
Mudbox 2013 64-bit\   
Nom : UninstallPath 
Données :  <InstallationDirectory>\Setup\Setup.exe /P {0C821839-EA2A-48C2-BBD5-
2B3D28159BC0} /M Mudbox /LANG ko-KR   en-US 
 
Pour Windows 32 bits  
Clé : HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\Autodesk 
Mudbox 2013 32-bit\   
Nom : UninstallPath 
Données :  <InstallationDirectory>\Setup\Setup.exe /P {A675D66E-0CBD-4A8F-0068-
82B774DD4C9E} /M Mudbox /LANG ko-KR   en-US 

 
Exemples de SDK : 

Sur Mac OS X, il est possible que les configurations de versions ne soient pas correctement compilées. 
Vous devez définir Active Architecture sur x86_64 dans Xcode. Pour ce faire :  
1. Ouvrez un exemple de projet dans Xcode.  
2. Dans la barre de menus, sélectionnez Project > Edit Project Settings.  

http://www.autodesk.com/mudbox-helpdownload-fra
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3. Sélectionnez l'onglet Build.  
4. Sous Architectures dans la fenêtre Setting, vérifiez que la valeur Architectures est définie sur 64-bit 
Intel.  
5. Fermez la fenêtre et procédez à la compilation à l'aide de la configuration de version.  

 
L'exemple PtexExtractor doit être compilé et copié dans le répertoire de compilation de PtexImporter 
pour qu'un lien soit établi entre les deux exemples.  
 
Pour créer l'exemple Turntable, installez Qt et exécutez moc dans les fichiers d'en-tête d'exemple. 
Reportez-vous au fichier Readme de l'exemple. 

Ressources supplémentaires 

Pour obtenir des instructions complètes sur l'installation et les licences, reportez-vous aux documents 

Aide sur l'installation et Aide sur les licences. Vous pouvez accéder à ces guides à partir du lien Aide sur 

l'installation du programme d'installation de Mudbox ou des pages suivantes :  

http://www.autodesk.com/mudbox-install-2013-fra 

http://www.autodesk.com/me-licensing-2013-fra 

Vous trouverez des informations sur les nouvelles fonctionnalités dans la rubrique "Nouveautés" de 

l'aide de Mudbox à l'adresse suivante :  

http://www.autodesk.com/mudbox-help-2013-fra-whatsnew 

Des ressources de formation Mudbox sont disponibles à l'adresse suivante :  

http://www.autodesk.com/mudbox-learningpath 

 

Consultez des vidéos de démonstration de Mudbox à l'adresse suivante : 

http://www.autodesk.com/mudbox-trainingvideos 

 

Vous trouverez des ressources de support et de dépannage à l'adresse suivante : 

http://www.autodesk.com/mudbox-support 

 

Pour obtenir la liste actualisée du matériel certifié pour Mudbox 2013, y compris les cartes graphiques, 

reportez-vous au tableau de certification Mudbox 2013 disponible à l'adresse suivante : 

http://www.autodesk.com/mudbox-hardware 

 

Pour vérifier la configuration système minimale requise pour Mudbox 2013, consultez la page suivante : 

www.autodesk.com/mudbox-systemreq-2013-fra 

 

De la documentation et des exemples pour le SDK Mudbox avec la version installée de Mudbox sont 

disponibles sous \Mudbox 2013\SDK ou en ligne à l'adresse suivante : 

http://www.autodesk.com/mudbox-sdkdoc-2013-enu 

 

http://www.autodesk.com/mudbox-install-2013-fra
http://www.autodesk.com/me-licensing-2013-fra
http://www.autodesk.com/mudbox-help-2013-fra-whatsnew
http://www.autodesk.com/mudbox-learningpath
http://www.autodesk.com/mudbox-trainingvideos
http://www.autodesk.com/mudbox-support
http://www.autodesk.com/mudbox-hardware
http://www.autodesk.com/mudbox-systemreq-2013-fra
http://www.autodesk.com/mudbox-sdkdoc-2013-enu
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programme de participation du client 

Au premier démarrage de Mudbox, la boîte de dialogue Programme de participation du client s'affiche. 

Si vous choisissez de rejoindre le programme de participation du client, Mudbox enverra 

automatiquement à Autodesk des informations sur la configuration système, les fonctions que vous 

utilisez le plus fréquemment, les problèmes que vous avez rencontrés et d'autres informations utiles à 

l'orientation future du produit. Pour plus d'informations, consultez la page 

http://www.autodesk.com/cip. 

 

Rapports d'erreurs du client (CER) 

Les rapports d'erreurs du client que nous soumettent les utilisateurs de nos produits nous sont d'une 

grande aide pour améliorer la stabilité de Mudbox. Nous vous remercions de prendre le temps de 

remplir ces rapports et d'y indiquer autant d'informations que possible sur les opérations que vous 

effectuiez lorsque l'erreur s'est produite. Ces détails renforceront l'utilité de ce rapport et seront 

particulièrement précieux pour l'équipe d'ingénierie d'Autodesk Mudbox.  

Pour plus d'informations sur les CER, consultez la page http://www.autodesk.com/cer.  
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